Create a Site Assessment in Context

Using Google Earth, Google Maps, Word, Excel, and Other Common &/or Free Tools

Note: These instructions, which can also be downloaded online at www.harvestingrainwater.com/rainwater-harvesting-
inforesources/water-harvesting-handouts/, were created for Macintosh OS 10.5-10.6. If you are using a PC or another Mac OS,
you can expect to need to use some slightly different methods to achieve these results, and that the appearance of your tools
will also vary. Google Maps also has a Google Earth Plug-In, which allows you to access many, if not all, features of Google Earth
previously available only through the application version.

1. Get Started with Google Earth & Google Maps

Google Earth: the Planet View
Open Google Earth and enter the target address in the box in the upper left-hand corner.
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Hit Enter or click the Magnifying Glass icon.
Adjust the zoom level so that the whole earth is
visible against the backdrop of outer space.
Rotate the earth so that the red pushpin icon
representing your site is in the center of the
image. It will be small, but visible!

Remove the political boundaries and other
manmade influences by clicking on the sidebar

button /] going to the Layers section, and
unchecking the boxes as needed.
Take a screenshot (on a Mac, shift-38-4, then click, drag, and release).

Google Earth or Google Maps: The Country View

Next, zoom in such that your site’s country shows in its entirety, in the context of its neighboring lands.
Compare the imagery available through Google Earth with that of Google Maps. As of this writing, Google
Maps imagery had been updated more recently and was better than that of Google Earth. Thus, the next
four images were sourced from Google Maps. Note that the site marker is in place on all levels.

Satellite

If you are in Map view, click the Satellite button
in the upper right corner to see more viewing
options. If the Labels option is turned on, click to
turn it off.

to switch views. Hover over the Maps button L=
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Take a screenshot of your site’s country, in this
case, the Continental United States of America.
See the Word section below for instructions on
how to label the image’s source. Add a caption,
using the sample Site Assessment in Context as a
guide if you wish.



Google Earth or Google Maps: The Bioregion View

Next, zoom in and take a screenshot of the
significant bioregion in which your site is
located. Here, we are in the Sonoran Desert
bioregion. Include some of the surrounding
lands as context, as in the example to the left.
Again, add a caption, using the sample Site
Assessment in Context as a guide if you wish.

Find and include other resources that depict
more clearly the bioregion’s boundaries and
other features, such as rivers, mountains, and
major cities. See the sample Site Assessment in
Context for an example.

Google Earth or Google Maps: The Metro Region View

Now, zoom in to the extended metropolitan region level if your site is an urban one, or a comparable level
of detail if your site is a rural one. You’ll want to include significant local natural features such as
waterways, mountains, and bodies of water, as &
these provide important context to how your
site functions within its watershed. See the
Word section below for instructions on how to
label these significant local natural features.
Add a caption, using the sample Site
Assessment in Context as a guide if you wish.

This point in the Site Assessment in Context is a
good place for regional data such as climate,
rainfall, and other relevant place-based
information about your town or city. The
sample report shows a compilation of such
information. Similar data sheets for a number of other cities are available from (and being added
occasionally to) this webpage: www.harvestingrainwater.com/watergy-climate/. If you don’t see your city
listed, use the sources cited on an existing data sheet to guide you in creating one!

Google Earth or Google Maps: The Neighborhood View
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Next, zoom in to the level of your site’s
neighborhood. Use the Word instructions in
Section 2, below, to create a transparent
overlay to distinguish its boundaries, label key
roadways and natural features, and draw
informative lines and arrows, as shown in the
example on the left.

Here would be a good place to insert water-,
transportation-, lifestyle-related neighborhood
data, initiatives, resource maps, and other
relevant information. Ask your municipality for
resources you can’t find easily online. Either



they will have it or they will begin to realize that their citizens are interested in seeing these resources
created and made available. Again, examples are available in the sample report.

Possible Resources: One resource to consider for bicycle routes, trails, public transit, and other information
is Google Maps. These functions are still being developed, so if they seem lacking this time around, check
back next time this information could be useful. Google Maps also has a topographic maps function. These
topomaps are not consistently available for all regions of the globe, and are not necessarily very detailed,
they can be helpful when other alternatives are few, or difficult to obtain. To check for and view a
topographical Google Maps, simply locate the site, switch to Map view, and hover over the Satellite button
in the upper right corner of the window. Select the Terrain option from the menu that appears. If the
Terrain option is not available, zoom out one level and try again. Note: the contour interval will change
depending on the scale of the map, so pay attention accordingly.

Google Earth or Google Maps: The Site View

After you have gathered (or at begun to compile) your regional and neighborhood resources, the next
step is to zoom in to the level of the parcel of land that is the focus of your site assessment. Determine
your best resource (Google Earth, Google Maps, or perhaps a local source) for this zoom level. In this
instance, Google Earth was used. Although Google Maps had crisper imagery when viewed in 45-degree
mode (accessed by hovering over the Map button), you will need a straight-down view for this next step,
and Google Earth’s image quality was just as good as Google Maps’ for this view.

If Google Earth’s scale legend, like the one below, is not visible in the lower left corner of the screen, go to
the View menu and select Scale Legend. If the scale legend measurement is given in metric units and you
: 48 11 want to use standard U.S. units, hit command-comma (or go to the
| -_&_Yf : ! Google Earth menu in the toolbar and select Preferences...) to open
the Preferences window. From the 3D View tab, go to the Show Elevation panel and click the radio button
for Feet, Miles. Click Apply, then OK.

Preferences

(3D View | Cache Touring  Navi¢

While you are zooming in closer, hit the U key periodically to return the view Anisotropic Filtering Lab
to a straight-down orientation. As suggested above, the scale will not be ® off Q
accurate for the purposes of site consultation unless you are looking straight 8rfgd,:"m 8
down at the site. Note: If you use your computer’s plus & minus keys to zoom, show Hevation .
the angle will not tilt while zooming. You can turn off the automatic tilt function ) © Feet, Miles

by going to the Preferences window, clicking on the Navigation panel, and e O Meters, Kilometers | (—
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deselecting “Automatically tilt while zooming.”

In order to calculate a good approximation of the scale of the image shown on your screen, divide the
number of feet represented by the full length of the scale legend (48 feet in the image above) by the
length in inches of the actual scale legend on your screen (it was 2.5 inches long on this screen). This will
give you an idea of how many feet-on-the-ground are represented by each inch-on-the-screen. In this
example, each screen-inch represents about 19.2 ground-feet. You can also work backwards to customize
your scale to suit your needs. If you know you want each screen-inch to equal x ground-feet, for example,
and you know that your scale legend is y screen-inches long, multiply these two numbers together, and
then zoom in to the point where the full length of the scale legend represents the product of the two
numbers. Note: Due to the curvature of the earth and limitations of technology, these numbers will not be
completely accurate. Technology, as handy as it can be, is no substitute for reality!

If you would like to double check your scale, use the Ruler tool to create a line on the screen whose Google
Earth-stated length you can compare to its length measured with the appropriate scale ruler. To use the



Ruler tool, click on the ruler icon button in the toolbar. Open the Line panel from the Ruler window
and use the drop-down menu to select the desired units.
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Uncheck the Mouse Navigation box if it is checked. Move the
Ruler window out of the way to one side, as it must be left
open to use the tool. Click, drag and release to draw one line at
a time. The length of each line drawn will be displayed in
succession in the Ruler window. To remove a previously drawn
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line, click the Clear button, or just begin to draw a new line. Click on one end of an existing line and drag
that end to a new location to pivot the line to a new location with a common terminus. Using this Ruler
tool or your scale ruler is one way (see the Word section for another method) to measure the relevant
building lengths and property distances. Until you become familiar with this process, consider making
initial measurements from the screen, and compare them to your printed-to-paper version to make sure
your scale is being preserved in print, as the computer does not preserve scale on its own from the digital
form of a document to its printed form.*

With your zoom level in place,
and your scale calculated, now
take your screenshot of the lot,
right up to and including some of
the street if possible. Be sure to
include the scale legend in your
screenshot. If you want to include
stormwater in your water
budget, stretch the boundaries of
your shot to include the high
point in the middle of the street,
as was done in the image to the
left. If north is not toward the top
L of the image, note which edge of
the property is to the north. See the next sectlon to learn how to create the overlays, labels, and arrows
you see above, and to calculate the volume of your incoming rainwater.

Optional: Visit Google Maps’ street view of the property (available via the Google Maps toolbar button in
Google Earth), and take a screen shot of the front view of the property. You can scroll left and right to find
the most helpful view of the property.

Note: To preserve the scale you created above as you transition from digital
to printed format, print this file as an unmodified PNG, or as an unmodified

EEmmeEe= |- image Saved As a JPG. Open the print window and set the orientation to
s match that of the image (portrait or landscape). Change the scale to print at
] 79%* of full size (see the image to the left for visual instructions). To apply this
voursioe (WSt T8 asoby 10 change of scale, click in the Copies field, or the one of the Pages From fields. If

all goes as expected, your scale will carry through to the printed page.

* Troubleshooting scale inconsistencies: First, it’s best to print only one scale-

O scale: 79%

=g = O O\ s s sensitive image per page, and perhaps print only one page at a time if you are
P——— e g having trouble preserving your scale. Below is an example of how to correct
lutleopes ey g the scale if the instructions above have not kept it consistent in the digital-to-

print process, and if it is important under your circumstances that the scales

® ; . .
on both media are the same. Otherwise you could just recalculate the scale.




Let’s say the scale on the screen for the whole property was one inch:140 feet, so when | printed the Word-generated image at 79%
as indicated at the end of Section 1, | expected the 770 feet between the road and the river (which I had measured on the screen)
would measure 5.5 inches (on-the-ground measurement in feet + number of feet to an inch = expected number of inches on the
page. In this case, 770 + 140 = 5.5). However, when | measured the line on the printed page, it measured 6.3 inches. To correct this, |
divided the expected measurement (5.5 inches) by what the line actually measured (5.5 + 6.3 = 0.873). | then multiplied the scale at
which I had originally printed the image (79%) by this result (0.873); the result (rounded to the nearest whole number) was 69%.
When I reprinted the image, | put 69% in the scale field, and voila: the line on the printed page measured exactly 5.5 inches.
Whatever it is that causes these inconsistencies, this method should work to correct them.

2. Use Word to Create a Site Assessment Report and
Label Maps and Catchment Areas

There are lots of little details you’ll need to understand to use Word as a drawing tool, but each individual detail is
pretty simple, the tool is quite versatile, and the learning curve is not steep. These instructions are not intended to be
comprehensive, but rather to give you a foundation from which to continue to hone your skills. Keep in mind that these
instructions were created using Word for Mac 2004. If you are using another version, appearances and functions are
likely to vary, perhaps significantly.

Open a blank Word document. Use File > Page Setup... to set the orientation to portrait or landscape. The
latter is usually best, since many of your screenshots are likely to be oriented horizontally.

With a real-world ruler at hand, adjust the zoom level (View > Zoom...) on your screen so that aninch on
the virtual ruler across the top of your Word window measures exactly one real inch. (On my screen, this
happens when | adjust my zoom to 158%, but computers will of course vary.) This step is key!

Inserting Pictures

Prepare to insert your images and media into the document. Before inserting your pictures, consider
reducing their file size so that you still have good image quality, but without creating an enormous file that
might be difficult to share or upload, or which simply eats up a lot of storage space. To reduce the file size
you can import your images into iPhoto, and then export them, making them smaller files or lower-quality
images as part of the export process.

From the menu bar, choose Insert > Picture > From File... to locate and insert your existing Google
Earth/Maps screenshots or other images. If you use an image of the site that shows the scale ruler in the bottom
left corner of your screenshot, and use only rectangles and right/isosceles triangles overlaid on your image, you’ll be able
to calculate the area of each of your catchment surfaces (see Section 3 for details). If the image you want to insert is
on your desktop, you can drag and drop it into place in the Word document. Once it is in place, you can
single-click it and then drag one of its corners to resize the image.

You can also format pictures to be right- or left-aligned, and to allow the text to flow around the picture.
To format a picture in this way, control-click it and select Format Picture from the menu. Click the Layout
tab from the window that appears. For Wrapping Style choose Square, and then choose Left or Right
alignment. Choosing Other or Center can cause complications. Click OK. A formatted picture can be
grabbed, dragged, and dropped into place within the document, and the flow of text will adjust
automatically around it.

Layering Considerations
If you want to create a shape over or around certain sections of a picture to delineate neighborhood
boundaries or rainwater catchment areas, you will need to keep in mind that the order of operations does



matter. If you put a larger shape over another drawn object, you will have to move the top one aside to
access the bottom one. You will make the process easier for yourself if you lay down the largest shapes
first, and stack the smaller ones on top of them.

Before Drawing Lines and Shapes
Go to View > Toolbars > Drawing to show the Drawing toolbar on your screen. From the Drawing toolbar,

click the Draw button #~ and select # Crid-. Make sure that both boxes in Snap To
the Snap To section are unchecked. Otherwise you can have trouble getting S S

. . () Snap objects to other objects
your lines/shapes to appear precisely where you need them to be.

Using the Rectangle Tool
The easiest-to-use tool on the Drawing toolbar if you want to outline catchment areas is the Rectangle
tool. Understandably, this is most appropriate when the surfaces from which you want to harvest water

have 9o-degree corners. The Rectangle button looks like this: O

a. Click and release the Rectangle button. This turns your cursor into a set of crosshairs.

b. Position the crosshairs on one corner of the rectangular area you want to outline.

c. Click and hold, dragging the crosshairs to the corner that’s diagonal from your starting point.
d. Release. You'll get a white rectangle that looks something like this:

e. Click on it and release, and it will look like this: m

You can then click & hold the little perimeter boxes on the sides or corners, and drag & release them to
change the proportions or size of your rectangle.

f. When your cursor appears as an open hand, click and hold, and you can drag & release the rectangle to
another position on the screen. If you are trying to move around a picture of a shape, though, you will
need to format it first, as described above.

g. Double click (with open-hand cursor) your rectangle and you get the Format AutoShape window with
two handy tabs, the Colors and Lines tab and the Size tab:

L
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Use the Colors and Lines tab to set the color of the fill in your rectangle (or make its fill partially or
completely transparent), or to change the color, style, and weight (thickness) of the outline of your
rectangle (or make its outline partially or completely transparent (or, opt for No Line)). When the fill is
100% transparent (or if you choose No Fill), you have the benefit of being able to see clearly the features of
your image that are within/underneath the outline/rectangle.

Use the Size and Rotate section of the Size tab to view (and change, if you want) the exact dimensions of
your rectangle (and calculate its area, if you want), and to rotate your rectangle so that its edges align
accurately with those of the rectangular catchment area you are outlining when the sides do not face due
North, South, East, and West.

Note: if you single-click on your rectangle (or other object) such that the little perimeter boxes appear around
it and the cursor changes to an open hand when you hover over it, you can then use the directional arrows on
your keyboard as another method to steer/nudge it into position.

Drawing Freeform Polygons
Do not use this function if you want to be able to calculate the area in side the shape. It is best suited for
visual purposes only, such as to delineate neighborhood boundaries.

From the Drawing toolbar, click the Lines button & and select Freeform €2, position your crosshairs
over the spot you would like to begin drawing your shape. Click once and release, move your crosshairs to
the next point where the angle of the line needs to change, click and release again, and repeat until your
last click closes your shape.

Use the techniques described above for rectangles to format your shape (set the color and transparency
of the fill, or select No Fill; and set the color, weight, and style of its outline, or choose No Line).

Drawing Right/Isosceles Triangles

Click the Auto Shapes button =" to access the Basic Shapes menu. Select your triangle: either right or
isoceles. There are other options, but keep in mind that you want to keep it simple and regular enough to
be able to calculate its area accurately later on. Once you select your triangle, the cursor becomes the
crosshairs. Click and release on your image to insert a preliminary triangle of choice. Use the perimeter
boxes to change the dimensions of your triangle (be careful not to distort it), and double-click to access
the Format AutoShape menu (both as with the rectangles, above).

If you need to rotate by 9o degrees or get a mirror image of the triangle, click and release it such that the

perimeter boxes appear. Then click on the Draw button 4~ on your Drawing toolbar, and choose Rotate
or Flip from the subsequent menu. Proceed to select whichever function you need to make your triangle fit
the circumstances.

Inserting Text Boxes

Once you have your rectangles (or other objects) in place, you will want to label some of them. To do this,
first single-click any of your drawn objects or set the cursor in some nearby text. Otherwise, sometimes when you insert
the text box, it will wipe out a picture on the same page. If this happens, go immediately to Edit > Undo to restore.

With one of your drawn objects selected, go to the Drawing toolbar and click the Text Box button: Al

Follow the same steps as to draw a rectangle. Your text box will look something like this at first:



o ZnZ Note that when you click inside the text box and get a blinking cursor, you can

7 | ~  add/modify text, but to treat the text box as an object (e.g., to be able to

= ? nudge/drag it to a new position, modify its fill and outline, rotate it, delete it

2 / completely...), you must click on its perimeter. Notice how the appearance of the
AV

text box’s perimeter changes when you click on the text box in different places.

As with shapes, you can grab, drag, and release the text box’s perimeter boxes to change its shape. In
order to modify its fill and outline, hover your cursor over the perimeter to get the open-hand cursor.
Double click to get the Format Text Box window, which functions about the same as the Format
AutoShape window (above). Adjust the transparency of the fill and outline of a text box just as you can
with a rectangle or other shape.

Work inside the text box to add/modify text (font type, text color, text size, etc), much like you would in a
regular Word document.

Drawing Arrows
Arrows can be used to indicate the direction of flow of water, as well as simply to point to an object or
feature. Arrows can be made of straight lines, smooth curves, or completely customized lines:

T N = >

To draw straight arrows (good for indication direction of flow from a section of roof), select the straight

arrow from the Lines menu: ¥, Once you select the arrow option, click, drag, and release your crosshairs
to position the arrow. You can modify the position and length of a straight arrow by single-clicking and
dragging the whole arrow or by grabbing/dragging the terminus boxes, or change even more
characteristics and its point by positioning your cursor over the arrow to make the open hand appear, and
double clicking to get the Format AutoShape window.

To draw a smooth curvy arrow, select Curve from the Lines button menu. Click and release to set the
starting point, click and release again to set the first curve, and repeat until you have reached the point
where you want to set the point. Double click to end the line, and then position your cursor over the line to
make the open hand appear, and double click again to get the Format AutoShape window, where you can
select a point and other traits.

To draw a custom arrow, select Scribble from the Lines button menu. Click the crosshairs to get a pencil
icon and start your line, and release after you’ve completed it. Set point and modify line characteristics as
with the smooth curvy arrow above. For reasons unknown, sometimes the Scribble function will not work.

A Few Tips:

Once you have formatted an object in a certain way, if you want to make other objects with the same basic
formatting, you can copy and then paste the first one to avoid having to reset the font, text color, and
other characteristics on subsequent objects. Just change the text inside the box if necessary, get the item
into object mode, and then drag it into position.

The copy and paste approach can also be used if you have an object which, for visual reasons, you wish
were in the foreground of all of your layers instead of in the background. You still have to pile other layers
off of it, but once you get to it, you can copy and paste it, and delete the original. The new copy will
function as a top-layer object.



3. Use Excel to Calculate Catchment Areas & Rainfall Income

Excel is a less well-known than Word, but we’re not asking much of Excel here, so even if you’re new to it, this should be
doable and a hopefully a good introduction to the program. If you have questions about any of this, you are welcome to
direct them to admin@harvestingrainwater.com.

If you have used exclusively rectangles and right/isosceles triangles to section off your catchment areas,
you can now easily calculate the actual areas represented by these drawn shapes. If you are familiar with
the basics of Excel (or are up for learning some simple techniques) and are ready for a little number-
wrangling, this is relatively straightforward. You can also calculate the same information the old-fashioned
way if you prefer. Either way, read on....

1. Open an Excel workbook (or download and open the sample spreadsheet from the internet and follow
along, viewing what is already in the cells rather than entering values and formulas of your own). Click and
release a cell to add (or view) content. This can be done directly in the cell or by selecting it and working
from the Formula Bar (similar in appearance to a URL bar when surfing the web) at the top of your
window. In order to be able to refer to the sample spreadsheet included below, make column D for Height

(inches), column E for Width (inches), and column F for Area (sq inches). (Note: Although one would typically use
Length & Width rather than Height & Width in this context, Word’s Format AutoShapes window uses the label of Height instead of
Length; for consistency, so will we.)

2. Obtain the Height and Width of each rectangle or right/isosceles triangle from the Format AutoShapes
window for each shape. (It’s helpful to have labeled each section with a letter or number or a combination thereof
— these can be listed in column C.) Enter the dimensions into columns D and E, starting with row 11. You can
modify the appearance and form of numerical values by selecting the cell(s) and then going to Format >
Cells... and using the Number tab of the Format Cells window.

3. Select the first cell of the Area column (F11, in the sample below). If your first shape is a rectangle, write
in the formula for the area of a rectangle: height x width. The Excel way of saying this is =D11*E11. Type this
into F11 (or, simply note that this formula is already written into this cell if you are not starting from
scratch). Hit Return after you enter any formula or value in a cell. Copy this formula down throughout the
column as far down as needed. This can be done by clicking & releasing the original cell with the formula in
it (F11), grabbing the right lower corner box of this cell, and trailing down the column, releasing when you
reach the last relevant catchment area’s cell. Or you can just type the formula in each box, being sure to
refer to the correct height and width cells for each area. Afterward, go back into the F column for any row
whose shape is a triangle and edit the formula so that it will calculate the area of a triangle: height x width
X 0.5. For example, if the shape in row 11 were a triangle, you would make the formula in F11 read:
=D11*E11*0.5. The other formulas will continue to calculate area of a rectangle unless you change them.

4. This step explains how to calculate your area ratio, as opposed to the length ratio described earlier. The
current version of the spreadsheet has this calculation built into it, so if you have downloaded this from
the website to adapt for your site, you can go straight to this spreadsheet and enter the average annual
rainfall in cell H4, enter the values from the first part of step (a) below in cells E44 and H44, respectively,
and skip steps (b) and (¢).

a1. Use an actual ruler to measure the length of the scale ruler on the image on your screen (only if
you set the zoom level as described in the very first step of these Section 2) or printed page (only if
you succeeded in preserving the scale from digital to printed versions). If your scales are not
accurate, neither will the resultant data. Note how much on-the-ground distance this entire scale
ruler represents.

For example, on my screen the scale ruler measured 2.5 inches, and represented 48 feet.
(2.5 inches:48 feet)



a2. Square both sides of your length ratio to find the area ratio. Keep your units in the picture.

2.5 inches squared = 6.25 square inches, and 48 feet squared = 2,304 square feet.
(6.25 sq in:2,304 sq ft)

a3. Divide both sides of the ratio by the number of square inches on the left. You now know how
much actual area is represented by each square inch on your screen.

6.25sqin+6.25=1sqin and 2,304 sq ft + 6.25 = 368.6 sq ft
Therefore, 15q in:368.6 sq ft

b. Create a new column (G) titled something like Actual Sq Ft. In the first catchment area’s cell in
this new column (G11) enter the formula “=F11*x” where x = the number of square feet represented
by each square inch, as calculated in Step 4a.

e.g., =F11*368.6

c. Copy this formula down throughout the column as far down as needed, as you did above. You
now know the actual real-world catchment area for each section you outlined.

5. If you want to sum any or all of these actual real-world areas from column G (the cells must be
consecutive or separated only by empty cells), select the box where you’d like this data to appear (G33),
and insert the summing formula.

e.g., =sum(G11:G31)

6. To find the amount of rain falling on each catchment area in an average year, start by looking up what
the average annual rainfall is for the city in question. This is typically given in inches in the U.S.

e.g., In Tucson the average annual rainfall for the period of record of 1893-2009 is 11.56 inches
7. Divide this number by 12 inches per foot to convert from inches of rain to feet of rain.
e.g., 11.56 inches + 12 inches per foot = 0.963 feet

8. Multiply the average annual feet of rain times the number of gallons in a cubic foot (7.48 gallons) to find
how much rain falls on each square foot of [your city] in the average year.

e.g., 0.963 * 7.48 = 7.203 gallons of rain fall on each square foot of Tucson in an average year

9. Now create column H, which could be called Rain (gal/yr). In the first cell of this column (H11), enter the
formula to convert catchment area to average annual rain income, using the value you generated in Step 8
above.

e.g., =G11*7.203

10. Copy this formula down throughout the column as far down as needed, using the same technique
described above. You now know the average annual rain income for each section you outlined.

11. Next, if you want to sum any or all of these sections’ average annual rain incomes from column F (the
cells must be consecutive), select the box where you’d like this data to appear (H33), and insert the
summing formula.

e.g., =sum(H11:H31)

12. Once you have done the calculations for all of your catchment areas, and added all areas’ volumes
together, you will know how much rain falls on your overall catchment area in an average year. This
information is an integral component of your water budget.

On the following page is a screenshot of a sample Excel file created with these instructions.
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1 813 N 9th Ave, Tucson AZ
2 Rainwater Catchment Areas & Their Average Annual Rainfall Incomes
Pl
k& Givens: Tucson's average annual rainfall (inches):
5 Tucson's average annual rainfal (feet): 0.963
6 Gallons in one cubic foot: 7.48
7 Gallons of rain that fall on one square foot of Tucson in ayear: 7.203
8
9 Rainwater Catchment by Location (see ma indcates cachmertares
10 ScleHeght  ScleWd  Scledvws | Scuare Feet | Ran (galyr)
11 A1 025 05 0.13 46 331
12 A2 132 0.58 0.77 282 2031
13 A3 0.1 0.63 013 49 353
14 A4 0.35 0.35 0.06 n 79
15 As 0.35 0.35 0.06 n 79
16 A 0.35 0.7 0257 90 648
17 A7 0.35 0.35 0.06 n 79
B AB 0.35 0.35 0.06 " 79
119 Ag o 0.77 0.46 60 432
- | 20 A10 0.43 02 0.03 10 72
- | 21 A1 078 0.39 0.30 12 8oy
= 22 A12 .32 058 0.77 282 2031
| 23 A3 0.5 05 043 46 N
- | 25 B1 124 0.37 046 169 1217
C | 26 32 124 0.37 046 169 1217
Ez 28 C1 0.55 0.82 045 166 1196
- | 29 -2 047 0.8 0.08 3 223
C |31 D 0.58 098 0.57 210 1513
E’: 33 Total Roof Catchment Area & Rainfall: ¥ 1766 4 12,718
- [ 34
- [ 35 1. (notingl A, B, €) 2.38 7.03 12387 3009 21,674
- | 36 2. (notinc! areat) 342 8.13 107 4070 29,316
- | 37 3. (notincl areas 1 &2) 438 9.1 185 4356 31,376
" | 39 Total Ground Catchment Area & Rainfall: 11,435 82,366
C | 41 PROPERTY TOTALS: 13,201 95,084
- | 4Z squae foet Ran(gdhye)
E 44 Memusedbrgthofscaenirnt[ 25 | Mmbroffetepment| 48 |
— | 45 *Thesfor, onesquaenchrepresents|  368.64 | squaefeet
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4. Other Resources and Tools

City of Tucson Digital Map Site

This tool offers local users a more detailed aerial picture than Pima MapGuide, all the same measurement
features of the county site, and will operate in any browser, unlike Pima MapGuide, which operates on only
a PC platform. You can use the City of Tucson Digital Map Site outside of city limits also. If you are looking
for a similar tool for another region, check with that region’s local government, as many municipalities
now offer such free, web-based services.

To access the tool, visit dot.tucsonaz.gov/mapcenter/. Click on "Planning and Development Services" next
to the purple pin. Use the tiny bulletin board in the upper left corner to pull up the layers. Measurement
abilities are under "Tools," the rest is pretty self-explanatory.

Note: As of February 2011, various browsers running on Macs and PCs were unable to contact the server for the maps
page of the City of Tucson website. Check with the City of Tucson if you encounter difficulties.

More to come!



